
ANNOUNCEMENTS 
 

Something Fun!  OCLC’s Top 1,000 List 

OCLC Research has compiled a list of the 1,000 books held by the greatest 
number of libraries in WorldCat.  OCLC used FRBR algorithms and human 
analysis to pull together editions, translations, and printings of each title in order 
to rank the intellectual work rather than a specific manifestation.  The resulting 
list is fascinating in itself, but then they subdivided the list by useful categories 
(e.g.: Children’s, Drama, Books Into Film), added fun factoids (e.g.: William 
Shakespeare has the most works on the list and Stephen King didn’t make the 
list at all), and included links to libraries for people who might want to find one 
of the titles.  They also compare the list to other “top 100” lists.  You can even 
download the list, if you so desire. 
 
To explore the list yourself, go to: 

<http://www.oclc.org/research/top1000/default.htm>   

Be careful!  As OCLC warns, the list can become addictive! 

Carla Dewey Urban and Virginia Dudley, MINITEX BATS 

 

 

GENERAL 

 

News from the MULS Office 

Union Listing Updating – PASSPORT is still the way  
 
MULS participating libraries are asked to continue keeping their holdings 
information in the OCLC Union List system up-to-date even while we prepare for  
migration of Union List (UL) functions to the Connexion browser.  The migration 
will bring a number of changes to Union Listing, but the essential need for 
accurate holdings data will continue both before and after migration. 
 
Before UL migration to Connexion in June 2005, the only path for editing or 
creating Local Data Records – soon to be known as “local holdings” – is through 

http://www.oclc.org/research/top1000/default.htm


the Passport system.  In order to update holdings data, you must have a Union 
List session set up in Passport and a valid authorization with FULL level access.  
This will be especially critical during the period when Passport Cataloging has 
been discontinued (in May 2005) and Union Listing has not yet migrated 
(currently planned for June 2005).  If you are unsure about the union list 
authorizations you are using and whether they will allow you access to Passport 
UL, feel free to contact Dave Linton in the MINITEX MULS unit (612-624-3360, 
800-462-5348, linto001@umn.edu) or Carlos Portillo in the MINITEX BATS unit 
(612-623-7362, 800-462-5348, porti002@tc.umn.edu). 
 
Batch Processing of LDRs – No new orders 
 
Libraries should also note that OCLC will not accept new orders for batch 
processing of LDR updates for the next few months.  Orders already in queue 
will continue to be processed, but no new data is being accepted prior to the 
implementation of the MARC 21 Format for Holdings Data (MFHD) and the 
migration to the Connexion browser.  It is not yet clear whether implementation 
of the new MFHD format will have other effects on Union List batch processing, 
but we look forward to its reintroduction after UL migration. 
 
Also, we have not determined whether this hiatus will affect the normal 
SERHOLD to OCLC batch updates, or if they will be processed as usual.  As soon 
as we know, we will notify our participating libraries so they can plan 
accordingly. 
 
We’re here to help with UL issues 
 
The migration of Union Listing to Connexion is clearly one of the biggest changes 
that OCLC-based union lists have had to deal with in some time.  There are 
many questions that are as yet answered and many issues that will affect the 
workflow of all our libraries.  Despite the uncertainty, the MINITEX MULS staff 
remain committed to helping our libraries prepare for the changes and maintain 
their holdings data.   
 
We hope to know more about the changes in holdings format that will come with 
MFHD implementation after the ALA Midwinter conference, and we will keep you 
informed as we learn more details.  If you would like help with current updating 
projects, please contact Dave Linton (612-624-3360, 800-462-5348, 
linto001@umn.edu) or Cecelia Boone (612-624-6353, 800-462-5348,                
c-boon@umn.edu) in the MINITEX MULS office. 
 
Dave Linton, MINITEX MULS 
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OCLC’s Online Services Center: What Can It Do For You? 
 
With OCLC’s Online Services Center (OSC), you can: 
 

1. Manage contact details about your library and staff.  
2. Place new orders and renewals of FirstSearch – both subscriptions and 

block searches. In the coming months other OCLC services will also be 
available for order and renewal.  

3. Track order history. 
 
Using the Online Service Center helps libraries save time because tasks are 
performed online and, in some cases, in real time. The Service Center is a secure 
site and offers a quick, easy way to order services, keep your library's contact 
and mailing address information up-to-date, and view your account information. 
  
Access the OCLC OSC 
 
The first step is to designate staff members with administrative authority. 
Typically, the library director assigns administrative authority to staff who will be 
using the OSC to order products and services and update their institution's OCLC 
account information. A temporary ID and password has been sent by 
OCLC to each library director.  
 
With that information, the director should follow these initial steps to establish a 
secure account for your library. 
 

1. Go to the Online Service Center at <https://www.oclc.org/servicecenter/> 
2. In the Log On box, enter the temporary ID and password assigned by 

OCLC  
3. Select the person to have administrator privileges (managing contact 

information, ordering FirstSearch) 
4. Click “Next” 
5. A screen will appear indicating that a temporary administrative log on has 

been emailed to the person selected to serve as the administrator. 
 
The administrative contact designated by the director will be asked via email to 
log on to the OSC and reset the password. At that point, they will be free to use 
the OSC. 
 
For assistance with setting up an account, contact Karen Docherty at                    
<kdochert@umn.edu>, 612-624-2924, 800-462-5348. 
 
Once the steps above have been completed, assigned library staff are able to 
manage contact details, order FirstSearch services, and track order history. 
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Manage Contacts, Roles, Addresses, and Passwords in the OSC 
 

1. Logon at <http://www.oclc.org/servicecenter/> 
2. Click on the desired link in the upper left corner (ex. “Manage Contacts”, 

“Manage Addresses”, etc.) 
3. Select the “Edit” button for the contact details you want to edit 
4. Make the changes to the record  
5. If you wish to grant this staff member privileges to log on to the OSC, 

please complete the “Logon information” section at the bottom of the 
form.  

6. Click on the “Submit” button 
 
Order FirstSearch databases or block searches in the OSC 
 

1. Logon at <http://www.oclc.org/servicecenter/>  
2. From the lower left side of the screen, select “Order FirstSearch” 
3. If you wish to renew a subscription, to add a new subscription to an 

existing authorization, or to add block searches to an existing 
authorization, select the appropriate button (either “Add Searches” or 
“Add” (add a new database subscription to an existing authorization)) 
from the “Current authorizations” section. 

4. To purchase block searches or subscribe to a database on a new 
authorization, select the “Begin” button from the “Create a new 
authorization” section 

5. Follow on-screen prompts for placing your order. 
 
For more information, check out the Online Service Center guided tour at 
<http://www.oclc.org/servicecenter/guidedtour/> or contact Karen Docherty at 
<kdochert@umn.edu>, 612-624-2924, 800-462-5348. 
 
Karen Docherty, MINITEX CPERS 
 
 
 
 

Migration Countdown 

As of January 1, 2004, there are only 4 months until the demise of Passport for 
Cataloging and Passport for ILL on May 1, 2005. 
 
Passport for Union Listing gets a little reprieve.  But it, too, will pass from the 
scene sometime during June, 2005. 
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CATALOGING & METADATA 
 

A Word about OCLC Connexion Training 

It is time to start thinking seriously about migrating to OCLC Connexion.  Do you 
have a plan?  Are you waiting for training? 
 
The MINITEX BATS unit is in the process of putting together our spring training 
schedule.  The calendar at the front of this Mailing lists classes that were 
scheduled as of January 3, 2005, but rest assured, there will be many more 
classes added.  We will be concentrating on full-day, hands-on Connexion Client 
training.  If, however, you prefer Connexion Browser training, please let us 
know, and we will consider offering it again. 

Watch the MINITEX News listserv for announcements of training sessions.  Also, 
visit the MINITEX Training and Conferences site for a list of all the current 
training offerings (<http://www.minitex.umn.edu/train-conf/>).   

Virginia Dudley, MINITEX BATS 

 

New OCLC Vendor Partner: Actrace 

 
Actrace, a Chinese language material vendor, has become both a PromptCat 
vendor and a Vendor Record Contribution Partner.   
 
Actrace, located near Boston, is a U.S. based representative of Shanghai Union 
Documentation & Information Corporation, Ltd. (SUDICL), a leading library 
service provider and cataloging center in China.  Actrace offers complete 
solutions for libraries of all types in North America to build Chinese language 
collections.  For more information, visit <http://www.actrace.com/>. 
 
OCLC began loading original MARC records for Actrace titles in October 2004.  
The records added have symbol ACTRA in the 040 field subfield c.  Actrace 
records contain both original Chinese script and transliterated data for the 
Chinese language titles.  The language of cataloging is English.  Some examples 
of newly added Actrace records are: #56822299; # 56821969; #56822301.  
When a record from Actrace matches a record already in WorldCat, the ACTRA 
symbol is added in subfield d of the 040 field (for example, see # 53839293).   
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In both cases of original records and matches, a 938 field is added to the MARC 
record that contains the vendor code ACTR.  This code is indexed; vendor 
records are searchable using the vendor information keyword index.  For a list of 
all partners contributing records through the Vendor Record Contribution 
Program, see:  

<http://www.oclc.org/vendors/material/participants/default.htm> 
 
In addition to contributing records, Actrace is a PromptCat partner, and can work 
with OCLC to deliver OCLC records to libraries who order titles from Actrace.  For 
more information about the PromptCat service, see: 

<http://www.oclc.org/promptcat/default.htm> 
 
For a complete list of current PromptCat partners, go to: 

<http://www.oclc.org/promptcat/about/vendors/> 
 

Cynthia M. Whitacre, OCLC 
 

Follett Library Resources Is Now a PromptCat Vendor 

 
Follett Library Resources has also joined the list of OCLC PromptCat vendors.   
 
Follett Library Resources supplies books, e-Books, and curriculum-focused 
audiovisual materials to K-12 schools.  They offer a wide range of products and 
services to schools and school libraries including collection analysis, collection 
development, opening day collections, curriculum support, physical processing of 
items, and much more.  To find out more about Follett Library Resources, go to 
<http://www.flr.follett.com/>. 
    
OCLC Product Update, 12/10/2004 
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OCLC Connexion Features 

 
Both the browser and client interfaces of OCLC Connexion are packed full of features that you may not know about, or have 
maybe forgotten about.  We will list a few of these in each issue of the Mailing in order to jog your memory and to help you 
make efficient use of Connexion.   
 

CONNEXION BROWSER FEATURES 
 

Keystroke Shortcuts  
 Command Shortcuts:  Connexion browser provides permanently assigned keystrokes for actions 

you can take on a bibliographic or authority record.  The Command Shortcuts list includes a 
keystroke for every command that appears on the Edit, Action, and View lists.  To show the 
Command Shortcuts list above the record header, press <Alt><K>. 

 
 Other:  To see a list of all the possible keystroke shortcuts, press <Shift><F7>.  The first section 

of this list, “Current Keystroke Assignments,” lists 18 keystrokes that you can customize if you 
wish.  As soon as you customize any or all of these, your assignment(s) will appear in this list. 

 
 Customize:  To customize any or all of the 18 assignable keystrokes, go to the GENERAL tab  

Admin Options  Preferences  General Options  Keystroke Shortcut Options.  If you want 
the changes you make to be permanent, make sure you press the “Save My Default” button. 

 
     

CONNEXION CLIENT FEATURES 
 
Keystroke Shortcuts 
You can perform all functions using only the keyboard.  The Client provides predefined keystrokes for 
the menu commands, editing, and entering diacritics and special characters.  You may customize any or 
all of these if you wish, and you may also add additional keystroke shortcuts. 

 Create or change a keystroke shortcut:  Go to the Tools menu  Keymaps.  Click on the “Help” 
button for a complete description of this dialog.  For additional help, go to the Help menu  
Client help  Index  <Type in the word ‘keystroke’>. 

 
 View or print keystroke assignments:  Go to the View menu  Assigned keys.   

 
Toolbar 
Although the Client supplies a default toolbar, you can easily customize it using the toolbar editor to add 
or remove buttons.   

 To customize:  Go to the Tools menu  Toolbar Editor.  Use the “Help” button provided on the 
dialog, and/or go to the Help menu  Client help  Index  <Type in the word ‘toolbar’>. 

 
 Assign custom user tools:  You may also assign up to 10 generic user tools by going to Tools  

User Tools  Assign.  
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MINITEX CONTRACT CATALOGING 
 

A Hole in the ConCats Team 

 
On December 16, the ConCats bid a sad farewell to Jane Young, who is leaving 
us for a position at Century College (though why one would want to leave the 
ConCats for a position that offers more money, three months off in the summer, 
and a thirty-mile-shorter-each-way commute is beyond us). Before coming to the 
ConCats in January 2000, Jane had worked at such libraries as the Walker Art 
Center Library and the Legislative Reference Library.  
 
During her time with us she was responsible for cataloging materials for a 
number of the state agency libraries and other libraries. She was active in 
planning and constructing the ConCats displays for the various state library 
association conferences in the last several years as well as staffing them. At our 
weekly staff meetings she always had good cataloging questions that often 
prompted a lot of discussion (of course, this could mean that our staff meetings 
might be shorter now!). Most of all, we’ll miss a person who was a dedicated, 
stimulating, and valuable member of the ConCats team.  
 
We wish her all the very best in her new venture. 
 
Conway, Constance, and the other ConCats 
 

 

 

 

RESOURCE SHARING 
 
 

A Word About OCLC ILL Training 
 
The MINITEX BATS unit will be offering training in the new OCLC ILL interface 
throughout the winter and spring.  Remember, the new interface is called 
WorldCat Resource Sharing, and all the old interfaces (Passport for ILL, ILL ME, 
ILL Web) are going away as of May 1, 2005.  Watch for announcements of the 
full-day, hands-on class entitled “ILL Basics Using WorldCat Resource Sharing.”  
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The calendar at the front of this Mailing shows that a few of these classes have 
already been scheduled.  There will be many more!   
 
The MINITEX Training and Conferences site 
(<http://www.minitex.umn.edu/train-conf/>) is the place to go for our current 
training offerings.  As each new session is scheduled, it is added to this site.  
Visit often! 
 
Virginia Dudley, MINITEX BATS 
 
 
 
 
 

REFERENCE  
 
 

Link From Worldcat To Your NetLibrary Titles 
 

Is your library registered for NetLibrary Shared Collection I or did your library 
contribute to Shared Collections II or III? If the answer is yes, not only can you 
link your patrons from your OPAC’s records out to NetLibrary, but you can also 
set up links from WorldCat to the full online content of your NetLibrary titles. 
 
Here’s how to do it: 
 

1. Logon to the FirstSearch administrative module at 
<http://firstsearch.oclc.org/admin/> 

2. Select the “Linking” tab 
3. Select “Outbound Linking” from the navigation bar under tabs 
4. Enter your NetLibrary account number in the NetLibrary section.  

Note: To retrieve your NetLibrary account number  logon to the
NetLibrary “Library Resource Center” at 
<

,  

http://extranet.netlibrary.com/resourcecenter/index.asp>. Your account 
number is at the bottom of the “Home” page in the “OCLC FirstSearch” 
section. If you do not have a use name and password, you will need to 
create them. To create a username and password click on the "Create a 
Free Account" link in the upper right corner of the 
<

r

http://www.netlibrary.com/> site. Once you have created an account (or 
if you already have an existing personal account), email 
<support@netlibrary.com> and request that they allow you  account to
access the Library Resource Center for your institution.

r  
 

5. Click on “Save Changes” 
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Are there other FirstSearch linking opportunities? 
 
You bet! There are two options for linking with OCLC services. Inbound links 
start at a partner service and connect a user to WorldCat. Outbound links 
originate in WorldCat and connect a user to your library catalogs, other library 
catalogs and online services.  
 
 
Link to WorldCat from: 
 

• Bowker booksinprint.com 
• CSA databases 
• EBSCOhost 
• Ex Libris SFX 
• Gale InfoTrac 
• Innovative Interfaces WebBridge 
• ProQuest databases 

 
Link from WorldCat to: 
 

• NetLibrary (see steps above) 
• JSTOR 
• InfoTrieve 
• ABEbooks, ABELibrary, Alibris, Antiquarian Booksellers Association of 

America (ABAA) 
 
Set up links from FirstSearch to your Web Catalog 
  

• Users view local ownership and holdings information in your Web catalog 
while in FirstSearch – keeps your library foremost as the key information 
provider.  

• Activating this feature also ensures that your library’s holdings and 
ownership information will be available to end users finding material via 
the Google/Open WorldCat project. 

 
To learn how to set-up these and other FirstSearch linking options, take a look at 
the booklet on the OCLC Web site: 

<http://www.oclc.org/firstsearch/administrative/linking/partner_links_boo
klet.pdf>. 

 
Karen Docherty, MINITEX CPERS 
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Using WorldCat Efficiently 
 

WorldCat’s ever-increasing usefulness and visibility make it popular among library 
staff and patrons. With the advent of the following initiatives, WorldCat activity 
will continue to grow: 
 

• Links from the patron side of WorldCat to the resource sharing staff view 
• Google Scholar 
• Open WorldCat 
• Linking features from and to other resources 
• Google Digitization initiative 
• Internal features, such as “More like this,” and links back to holdings, and 

more 
 

Since Minnesota, North Dakota and South Dakota each provide shared, statewide 
access to the OCLC WorldCat database, it’s important that we all remember to 
use WorldCat efficiently. Here are some suggestions for doing so: 
 

• Sign up for a Bibliographic Instruction authorization for your library 
instruction sessions. Instead of using your statewide access for 
training/bibliographic instruction purposes, use a BI authorization. That 
way, an entire class of students will not tie up your state’s ports. To learn 
how, visit <http://www.minitex.umn.edu/cpers/firstsearch/bi.asp> 

 

• Encourage fellow staff and patrons to close out of their WorldCat sessions 
by clicking on the “Exit” link in the upper right corner of the screen. 
Sessions will time out automatically (see next point), but by actively 
logging out, you ensure that you are immediately freeing a port for the 
next user. 

 

• In the FirstSearch administrative module, set your library’s automatic time 
out limit to a low number, such as 5 minutes (select any number between 
5 and 30). By default, the time out is set for 15 minutes. If a user does 
not send a request to FirstSearch for several minutes, FirstSearch 
automatically ends the session. Timeouts lets you specify the number of 
minutes that FirstSearch waits for a request before ending a session. To 
set this feature in the FirstSearch administrative module                                                   
(<http://firstsearch.oclc.org/admin/>), click “General” in the 
Authentication/Access section of the main menu to go to the General 
screen that contains “Timeouts.” You have the option to set the full-text 
time out to a higher number to allow patrons a greater amount of time to 
read an item online. 

 

• In the FirstSearch administrative module, select the “E-mail Only Full Text 
Delivery Method” by placing a check in the box if you want users to view 
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full text only by sending it to themselves from FirstSearch in an e-mail 
message. If this option is checked, users cannot view or print full text in 
FirstSearch. Consider this option if you want to limit the time that users 
spend in FirstSearch or if printers are not available for printing full text in 
FirstSearch. This feature applies for the most part to other FirstSearch 
databases with full-text. To set this feature in the FirstSearch 
administrative module (<http:// firstsearch.oclc.org/admin/>), click 
“General” in the Authentication/Access section of the main menu to go to 
the General screen that contains “Full Text Delivery Method.” 

 
Karen Docherty, MINITEX CPERS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Contact Information 
   
MINITEX Bibliographic and Technical Services (BATS), 612-624-4002, 800-462-
5348, mino@othello.minitex.umn.edu  (Carla Dewey Urban, Virginia Dudley, 
Carlos Portillo) 

OCLC Cataloging, ILL, Digitization and Preservation products and services
 
Karen Docherty, MINITEX Cooperative Purchasing & Electronic Resources 
Services (CPERS), 612-624-2924, 800-462-5348, kdochert@u

OCLC Reference products and services  
 

Cecelia Boone, 612-624-6353, 800-462-5348, c-boon@umn.edu   
Dave Linton, 612-624-3360, 800-462-5348, linto001@umn.edu   

OCLC Union Listing, including MULS 

mn.edu 
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